CONTENTS

Addenda

Hardware Notes

DLC Scroll Specification: Six & Eight-Lamp
DLC Overall Dimensions: Six & Eight Lamp
Pitching DLC: Overall Dimensions
Light Talk Cabling & Connections; Tech Note No.10
Troubleshooting Guide; Technical Note No.8
Optical Sensor Testing & Adjustment; Tech Note No.5

Light Moves Software Manual
  Configuration
  Operation

Light Talk

Light Moves Release 1.2 Supplement
Use of Modifier Keys with Light Moves

Error Return Codes

Macintosh Serial Port to Light Talk Lead
Analogue Remote Control for Light Moves; Tech Note No.4
Zero to Minus Ten Volt Remote Control for Light Moves; Tech Note No.9
Strand Lightpalette90 Remote Control for Light Moves; Tech Note No.6
Celco 88 Series Remote Control for Light Moves; Tech Note No.7

DMX-Light Talk Controller

Light-Talk Splitter Operating Notes

Declaration of Conformity
ADDENDA

Installation of Colour Scroll

With the DLC in the colour 1 position, slowly roll the scroll onto the Removable Roller. Remove the tapes but maintain a hold of both rollers. **Do not allow the Fixed (tensioned) Roller to spin back freely** - it should be controlled. Failure to do this can result in damage to the Clutch Spring. Push the Removable Roller towards the free end to release it.

Upright Digital Light Curtains

Please note that contrary to the manual it is possible with recent Digital Light Curtains to mount them in any position and not just horizontally.

If using Digital Light Curtains in an upright or near-upright position, they must be mounted with the drive end at the bottom. This ensures that natural convection cooling reinforces the fan cooling rather than opposing it and that the more delicate mechanisms and electronics are at the cool lower end.

This note applies to all Digital Light Curtains with serial numbers 10,000 and above. Earlier Digital Light Curtains need to be modified for upright operation.

Connection of Network Link

Connection to the instruments is now by means of an XLR-6 connector. Neutrik brand is recommended.
Hardware Notes
15 November, 1991

HARDWARE NOTES

Power Supply

The DIGITAL LIGHT CURTAIN is available in three voltage ranges: 100 v AC, 110-120 v AC and 220-240 v AC. Voltages are marked on the labels attached to the power supply units; ensure they are correct for your local supply. Conversion from one voltage range to another is possible by the installation of a replacement lamp transformer and the reconnection of internal jumpers in the power supply unit; contact your supplier for information.

Two separate sources of mains electricity of the appropriate voltage are required.

- Power for the lamps, which normally will come from an external dimmer or other control device, is to be connected to the heavy cable permanently fixed to the lamp transformer (or to the power supply unit in the 100 volt model, which has no lamp transformer). There are no internal fuses or adjustments in the lamp supply.

- Power for the drive motors, cooling fans and control logic, which must be from a non-dim source, is to be connected to the mains inlet on the power supply unit. The socket has a pull-out fuseholder, fitted with a 1-Amp fuse and a spare. A spring-clamp holds the plug in place.

A safety interlock interrupts power to the lamps when the rear cover of the instrument is opened. Consequently control power, as well as lamp power, is required to operate the lamps.

General Handling Precautions

While power is applied to the drive motors and logic circuit, the instrument must not be manually rotated. This could cause permanent damage to the control circuitry. If power is removed – unplug the IEC connector if in any doubt – it may freely be rotated about its axis, so long as it is not permitted to rotate beyond the straight-up position (lamps pointing at the yoke) in either direction. Before power is reconnected, ensure that the lamps are pointed away from the yoke.

Lamp Installation and Replacement

Lamps are 12-volt 240-watt PAR 56. The normal beamspread is designated VNSP (Very Narrow Spot); Medium Flood and Wide Flood versions are also available, as are 120-watt alternatives.

The eight lamps in each instrument are connected in series; consequently a single fused filament will break the circuit to all eight lamps. The faulty lamp(s) can be identified by examining the indicator lights beside each lamp while lamp power is applied to the unit; a lighted indicator marks a faulty lamp.

- Disconnect lamp power.
- Disengage the five latching screws of the rear cover by turning each a quarter-turn anti-clockwise, and open the cover.
- Disconnect the two orange power leads from the terminals of the lamp(s) you are
replacing.

Two of the three retaining brackets holding each lamp are secured by slotted screws. Loosen these sufficiently to permit the retaining brackets to slide away from the lamp. You may find it convenient to retighten the screws to hold the bracket out of the way while the lamp is being changed.

Remove the old lamp by sliding it from under the one remaining bracket.

Install the new lamp by sliding one of the locating tabs near its rim under the fixed bracket. Note that there is only one possible orientation of the lamp that positions all three tabs correctly opposite their retaining brackets, and that the lamp’s terminals will be horizontally aligned when it is in the correct position.

Slide the two movable retaining brackets toward the lamp and tighten the slotted screws holding them in place.

Connect the two orange power leads to the lamp’s terminals.

Close the rear cover and secure it by turning the five latching screws a quarter-turn clockwise after they have been seated in their sockets.

**Preparation of Colour Scroll**

A colour scroll consists of up to 20 strips of coloured gel taped together as detailed in Appendix 1, and wound onto the detachable roller. Markers of opaque tape are used as shown to denote the colour divisions and the extreme ends of the roll.

**Installation of Colour Scroll**

As a precaution against permanently damaging the control circuitry, the colour rollers must not be moved manually at high speed while control power is applied.

Facing the front of the unit, unlatch and open the top and bottom cover plates by sliding the two protruding latch tabs of each, located between the first and second lamps from each end, inward and pivoting the covers back on their hinges.

One of the two rollers – the upper one when you face the instrument with its drive-train to your right – is fixed, the other detachable. If an existing colour roll is to be removed, it must first be wound entirely onto the detachable roller. This is most easily done by sending the unit to Colour 1 under computer control, but it can be accomplished manually by rotating the rollers in the required direction.

Unfasten the tape holding the end of the scroll to the fixed roller – use a small piece of it to prevent the colours unwinding from the detachable roller.

Grasp the detachable roller with its colours, and push it away from its drive-train end, against the spring pressure. There will be sufficient clearance at the drive-train end to remove the roller from the instrument entirely.

Insert the replacement roller and colours by first seating one end onto the bearing at the
non-drive end of the instrument. The roller itself will fit either way around, so ensure that the leading edge of the colour roll unwinds from the side of the roller nearest to you.

Push the roller against the spring pressure, away from its drive end, until there is sufficient clearance to engage the roller on its drive spindle and two locating pins. If necessary, turn the knurled ring on the spindle whilst holding the roller still, until the locating pins slip firmly into the corresponding holes in the roller.

Wind the leading edge of the colour roll between the two poles of the tape sensor at the drive end, and over the fixed roller. Attach it firmly to the fixed roller with tape, taking special care that the colour is attached squarely and without buckling, and that there is a clearance of between 2 - 5 mm between the edge of the colour and the knurled ring at the drive end of the fixed roller.

Wind the colour roll on so that the taped join to the fixed roller is covered by at least one layer of colour.

Tension must be applied between the two rollers to eliminate slack and ensure correct operation. Holding the detachable roller immobile, turn the knurled ring at the drive end of the fixed roller in the same direction as the colour is winding. Considerable resistance will be felt as the friction-clutch driving the roller is forced to slip. When all slack has been removed from the colour, continue turning for approximately two further full revolutions of the knurled ring, to increase the spring pressure maintaining tension.

Wind the colour roll onward until the double tape marker denoting the start of the roll has passed through the tape sensor.

Finally, close and latch the two cover plates. The latch bolts will have to be held open while each cover is positioned, then released and allowed to slip positively into place.

If possible, observe the instrument while it is colour-calibrated, to ensure there is no binding or buckling as the colour roll winds from one end to the other.

**Physical Installation of the Light Curtain**

The DIGITAL LIGHT CURTAIN is normally suspended from two clamps attached to its yoke. Alternatively, the clamps may be removed and the instrument bolted to any rigid structure such as a floor or wall, so long as its tilt-axis remains horizontal.

Circulation of air around the instrument must not be obstructed.

**Connection of Network Link**

DIGITAL LIGHT CURTAIN s communicate with their controller via the RS-422 serial communications protocol over a daisy-chain of 6-conductor cable; connection to the instruments is by FCC-68 style telephone crimp-on connectors. The DIGITAL LIGHT CURTAIN s are serially linked: the first link will be from controller to the ‘Data In’ socket of the nearest DIGITAL LIGHT CURTAIN, the next from the ‘Data Out’ socket of that same instrument to ‘Data In’ of another, and so on. The chain ends at the last instrument.
A relay in each instrument will close when control power to that instrument is interrupted, maintaining the daisy-chain of command and response links even if several successive devices should be without power.

The order in which the instruments are linked in the series is immaterial, and is best determined by the shortest overall cable path.

Branching of the Network link requires an active splitter. Contact DHA Lighting, London, for further information.

For links between Light Curtains, or between controller and Light Curtain, of under 10 metres, unshielded telephone or data cable will normally be sufficient. For longer runs, or in environments of particularly strong r.f. activity, screened cable should be used, either as two twisted screened pairs or as four conductors with overall screening.

Details of connections to the computer may be found in Appendix 2.
SOFTWARE MANUAL

Light Moves has three main functions.

1. It provides a means of creating and amending a cue-sheet for the control of a large number of DIGITAL LIGHT CURTAIN s, and of collating and displaying the considerable amount of data this may generate in a systematic format that is meaningful to the designer and operator.

2. It translates the cue-sheet data into executable command-language statements to which the DIGITAL LIGHT CURTAIN s can respond.

3. It generates the Light Talk Network, the command link to the DIGITAL LIGHT CURTAIN s, serving as the command-post under performance conditions, and enabling the operator to perform numerous experimental, diagnostic and housekeeping functions.

This version of Light Moves is written for the Macintosh computer. Familiarity with basic Macintosh terminology and methods is assumed. See publications such as 'Macintosh SE Owner's Guide' for further information.

Running Light Moves

Light Moves should be run only under the Macintosh Finder. It cannot be assured always to function properly in all respects under Multifinder.

As with any Macintosh application programs, Light Moves may be entered by double-clicking on either the document icon, which will open an existing cue-sheet, or on the application icon, which will enter the program and then prompt for a cue-sheet title. This is the equivalent of the 'New' command in the File menu.

The default title given to a new cue-sheet is 'Untitled'. You may accept this, or enter a title of your own choice in the box. You will be warned if you attempt to create a new document with a name already in use:

```
“Untitled” exists. Open it?
Open   Cancel
```

You may then either open the existing document, or click on 'Cancel' and return to the selector box to
alter the title of your new cue-sheet. Clicking on 'Create' will cause the document to be created and **Light Moves** to enter Configure mode.

When a new cue-sheet is created, **Light Moves** always enters its Configure mode as the necessary first stage of writing the document. Since the configuration data is stored with the document, this stage is bypassed when an existing cue-sheet is reopened.

Clicking on the 'Cancel' button will cause no file to be opened and **Light Moves** will await further instructions via the File menu or equivalent keyboard commands.

While a cue-sheet is being read into memory, its title will be displayed for confirmation:

![Loading... Untitled](image)

**Locked Cue-Sheets**

It is not possible to work from a locked or protected cue-sheet, even though you may not intend to introduce any further changes to the document. It is suggested that backup copies be carefully maintained as a safeguard against inadvertent changes.
CONFIGURATION

Configuring the Cue-Sheet

Before any cues are written in a new cue-sheet, Light Moves must be given some information to enable it to communicate with the DIGITAL LIGHT CURTAIN s and to display their conditions correctly on the screen. The process is called Configuring. If you are creating a new cue-sheet, you will automatically be placed in Configure mode. You may also reconfigure a cue-sheet at any time, to alter the number of instruments, the colour selection, or some aspects of the display layout, by choosing 'Configure' from the Edit menu.

You are shown this screen:

![Configure Screen Diagram]

Defaults have already been entered for many of the values. These may not be entirely correct for your production, but most of them are best altered at a later stage. There are only a few values that should be edited immediately.

Near the top of the screen is a row of boxes:

![Units: Format Columns List Titles: ]

These values determine the number of DIGITAL LIGHT CURTAIN s that are to be operated from Light Moves, and the layout of the cue-sheet display on your screen.

-'Units' is the number of Light Curtains that will be used in this production. This value initially defaults to 20, but Light Moves will accept any number in the range 1-99.

-'Format' and 'Columns' together determine the layout of several elements in the cue-sheet display. The box after 'Format' is a pull-down menu, listing the four main display tables:
The table(s) selected will be displayed in the number of columns entered in the 'Columns' box. 'ALL' is the default and, unless altered, will set all four tables to the format in the 'Columns' box. Individual tables may be given differing widths by first entering the number of columns, then choosing the required table.

Columns may be in the range 1-9, defaulting to 2, but note that configurations that would produce empty columns will not be accepted – the 'OK' button at the bottom-right of the screen will become dimmed and inactive until a valid combination is entered.

'List Titles' is also a pop-up menu, determining whether identifying column-headings are to be shown above the tables in the cue-sheet display:

The default condition is labels shown for all tables, indicated by the tick-marks (' '). Choosing any item from the menu will toggle that item between ticked and un-ticked. If the four individual items are not identical, then 'ALL' is italicised ('ALL') to indicate that it is no longer active. Subsequently reselecting 'ALL' will remove the italics and override previous individual assignments.

Clicking on the 'OK' button or keying RETURN will store the values you have entered and return Light Moves to the cue-sheet view; clicking on 'Cancel' or the close box in the upper-left corner, or keying ESCAPE, will abort the Configuration process without recording any changes.

This top row of the Configure screen should be altered if necessary from its defaults and set to your preferred values at this stage.

The next area of the Configure screen is a table of instruments and their configuration values:
Note the scroll bar to the right of the table, permitting hidden entries to be brought into view.

The numbers in the 'Unit' column are the identifying labels which will always refer to one specific instrument; all references to instruments in the cue-sheet are made in terms of these unit numbers.

'Serial #' is a coded electronic identification number that is embedded in each DIGITAL LIGHT CURTAIN's own electronic circuitry. It is, conveniently, identical to the serial number marked on the top of each unit's power supply. It identifies an individual instrument to the computer, and entering it here will associate it with the corresponding Unit Number so that Light Moves will be able to communicate directly with any specific instrument via the Light Talk Network. One might make a plot of these serial numbers as the instruments are installed in order to be able to identify them at this stage. Alternatively, serial numbers may be assigned to their corresponding unit numbers via the 'Patch...' command in the •Special• menu (see Patch).

The next three parameters in the table relate to each Light Curtain's Tilt movement.

The DIGITAL LIGHT CURTAIN's on-board firmware permits the device to be rotated to any position up to within 5˚ of the yoke from either direction. A reference point, designated 0˚, may be established at any point within this range of movement, and all positional references will subsequently be relative to this point. Anticlockwise rotation (viewed from the device's drive end) produces positive tilt angles, clockwise rotation produces negative angles. The location of the 0˚ position is stored both in non-volatile Parameter RAM in the instrument itself, and in tables within Light Moves, and can be minutely adjusted (see Limits) to facilitate perfect alignment of any number of DIGITAL LIGHT CURTAIN's.

'Minimum' and 'Maximum' are the limits, also stored in Parameter RAM, of a unit's permitted axial rotation in either direction. Positive values indicate anticlockwise movement as seen from the drive-train end of the instrument, negative values clockwise. These parameters can be used, for example, to prevent a unit illuminating the scenery or shining in the audience’s eyes, overriding the instructions in a cue that would otherwise have sent it to such a position. Light Moves accepts a total range from Minimum to Maximum of up to 360˚, but note that the unit's own electronic circuitry will not permit it to rotate beyond a position 5˚ from the yoke, providing a total arc of 350˚. Minimum and Maximum are identified by reference to the current 0˚ position, and moving the latter will automatically cause them to be shifted a like amount.

Any command that would send a unit beyond its defined Minimum or Maximum (or its hardware limit) will be executed, but rotation will stop when the limit point is reached. No harm is done, and the next command that lies within permitted limits will be executed normally. The screen display of the unit's position will momentarily be inaccurate, but will correct itself when the next valid instruction is sent.
Values are accepted to one decimal place, from 0˚ to ±360.0 º. The defaults are -175˚ and +175˚ respectively, corresponding roughly to the maximum useful rotation when 0˚ is set to straight-down. Minimum and Maximum can be trimmed to precise on-stage positions via the 'Limits' command in the Status window (see Limits).

'Sense' may be Normal or Reverse, and inverts positive and negative degrees of rotation. This feature will be useful, for example, where units have not all been installed with their drives at the same ends.

The next two parameters in the table relate to each unit's colour control.

'Colours' is the number of colours installed on the unit, in the range 1-20. The default is 20, which is the maximum number the DIGITAL LIGHT CURTAIN is physically capable of accommodating.

'Sense', once again, may be Normal or Reverse, and inverts the numbering and direction of movement of the colour roll (i.e. Colour 1 will be at the opposite end of the roll).

Of these 6 parameters, Tilt Reverse, Colour Reverse and the number of Filters can be set only from Configure mode, and you should do so now if the information is known. Serial # may conveniently be set at this time, if the information is available. The Patch command in the •Special• menu provides an alternative method (see Patch).

To set or alter any of these parameters, one or more units must be selected from the Configuration values table, and Edit mode entered by double-clicking on a selected unit or choosing 'Edit Selection' in the Cue menu. You are presented a box:

```
Unit : 1  Serial : 0  OK  Cancel

☐ Reverse Tilt  Minimum -175  Maximum 175
☐ Reverse Colour  Colours 20
```

or, if more than one unit was selected,

```
Unit : 1  2  OK  Cancel

☐ Reverse Tilt  Minimum -175  Maximum 175
☐ Reverse Colour  Colours 20  ☐ Copy Colours
```

In this case, the 'Unit:' box is a pop-up menu from which further refinement of the selected units is possible and reversible, the 'Serial #' box is not present since it is impossible to assign the same serial number to more than one unit, and a check-box labelled 'Copy Colours' has been added. You will be able to enter values for the indicated parameters, but you will have to return to Edit mode afterward with each unit individually selected in turn in order to enter their serial numbers (if you choose to do it in this way rather than via 'Patch' in the •Special• menu).
'Copy Colours', which appears only if more than one unit has been selected, will, if ticked, cause the number of colours assigned to the Master Unit (see Master Unit) to be copied to all other ticked units in the current selection; it will also duplicate the list of colour descriptions in the panel to the right (see Colour List), if these have already been entered. It cannot copy a list of colours that has not yet been created! This can avoid much tedious typing, since these parameters will often be identical for many, if not all, of the DIGITAL LIGHT CURTAIN's in a rig.

Clicking on 'OK' will store the values currently displayed and return to the Configure screen. 'Cancel' aborts the editing process and returns to the Configure screen without recording any changes. Note that the 'OK' button becomes dimmed and inoperative if you enter invalid values.

In some circumstances it will appear impossible to enter what seems to be a permissible value into the Minimum or Maximum box: if, for example, the Maximum box already held a value of, say, 200', the Minimum box would not accept any value lower than −160', which would cause the total range to exceed 360'; even if it were your intention to proceed to enter a lower Maximum value, Light Moves' error-checking routine would recognise the temporary invalidity and block entry of the number. The approach in such a case is to enter first the lower Maximum value, which then brings the intended Minimum value within the acceptable range.

The panel at the right of the configuration table, headed 'Filter Description', will hold a list of the colour repertoire of any selected unit, or of the Master Unit of any multiple selection.

The Colours List

When one or more units are selected, a list of colour descriptions appears in the panel at the right of the display. The number in the heading identifies the selected unit, or the Master Unit if a multiple selection:

```
Filter Description (...unit 1)

1  Clear
2
3
4
5
6
7
8
9
10
```

These are the configured colours for the selected unit, or for the Master Unit if this is a multiple selection. By default, Light Moves assigns 20 colours to each instrument, the first being arbitrarily described as 'Clear', but this can easily be altered. The number of filters for each unit is determined when editing the Unit Table. The colour descriptions are edited by selecting the required colour number from this list (multiple selections are not possible here) and double-clicking. A box appears:
You may overtype your own description of the colour to be installed in the corresponding position on the colour roll. If for some reason you want a blank space to appear here, you should enter a space. Clicking on 'OK' will then record the new description. 'Cancel' will abort, leaving the existing description intact.

There remains one area at the bottom of the Configure screen:

These two duplicate sets of selection buttons configure the computer's two serial ports for a choice of external devices:

The Light Talk Network is the chain of command links from the computer to all of the installed DIGITAL LIGHT CURTAIN s.

The Remote Control (see also Remote Command) allows cues to be triggered by a remote lighting board. Interfaces are available for various popular lighting desks. Your version of Light Moves will have been supplied with the specified interface, as agreed when your order was confirmed, and this may be confirmed with the 'About Light Talk' command in the menu. Consult separate documentation for details of Remote operation.

Normally, the Light Talk Network will be assigned permanently to one of the two available ports, while the remote control device and the printer will have to be patched when required to the remaining port by re-entering Configure mode and clicking on the appropriate button. If a Remote is to be used, it will be necessary first to disable Apple Talk from the Chooser.

It will make no operational difference which of the two ports is selected for any of these devices, but of course the software assignment made here must correspond to the physical devices actually plugged into the respective sockets!

The 'OK' button dims if an illegal selection is made (e.g., assigning the printer to both ports).

The configuration process is now as near complete as is practical at this stage. It may be necessary to return to it later on, but for the present click on 'OK' to store your values. 'Cancel' will abort Configuration without storing any altered values.

If you have altered the values of Minimum, Maximum, Tilt Direction or Colour Direction, then it is important to note that these new parameters will not become effective until a 'Write PRAM' command is executed from the •Special• menu (see Write PRAM). This will store these new values in the Parameter RAM – an area of non-volatile memory in each individual Light Curtain.
OPERATION

Copying and Cloning the Cue-Sheet

If the configuration you have created is one you will be using repeatedly, as for example a fixed rig in a repertory theatre which may be used for a number of different productions, you may wish to save it as a template for future work, to avoid having to repeat the Configuration process. The command ‘Clone As...’ in the File menu allows you to save the Configuration data under a title of your choice. ‘Clone As...’ may be done at any time. It saves the number of units and their Serial Numbers, the number and descriptions of colour filters, and the layout of the cue-sheet, including your altered window positions. Any cues that may have been written when you ‘Clone As...’ will not be included in the new file.

If you wish to create a copy of the entire cue-sheet, use the ‘Copy As...’ command in the File menu. All cue-sheet data, including cues, will be saved under a new title.

You may note the absence of the customary ‘Save’ command in the File menu. Light Moves saves new or modified data to the file whenever alterations are made, and the file is consequently always up to date.

The Cue-Sheet Display

After configuring a new cue-sheet, or immediately upon opening an existing one, you are shown a screen like this:

These are the constant elements of the cue-sheet display. They may need some tailoring before they become the useful tool you will require, but you will find that the cue-sheet can be formatted into a large variety of useful shapes to suit your preference. This flexibility also facilitates making the fullest use of displays larger than the standard Macintosh screen.
At the top of the screen are the usual Macintosh pull-down menus. Some of these
commands have already been mentioned. Others will be discussed as they become
relevant.

In the upper-left corner is a legend telling you precisely what part of the cue-sheet is
currently being shown. This will be referred to as the 'current cue'. The legend will
constantly be updated to reflect the state of the current cue, indicating whether it is static
(In Cue n'), active ('Playing Cue n') or temporarily frozen ('Paused in Cue n').

To the right are two buttons that select which of Light Moves' two operating modes
is currently active (see Preview Mode, Stage Mode). The two modes are generally
identical, except that in Preview mode no commands are sent to the DIGITAL LIGHT
CURTAIN s, thus cues may freely be written and edited without affecting their on-stage
positions. In Stage mode, any alterations made to the cue-sheet are echoed by the Light
Curtains themselves. On first starting up or opening a new cue-sheet, Light Moves
initially enters Preview mode; it is not possible to enter Stage mode until the Light
Talk Network has been initialised (see Initialising the Light Talk Network).

The Unit Table

The upper panel of the display is the Unit Table, which shows the current state of each
unit:

At the moment, it may show only a few of the units you have configured, but the
window can be resized in the usual way, subject to limitations imposed in Configure.

The location, as well as the size, of the window can be altered by dragging it with the
OPTION key pressed.

The Unit Table shows the tilt position and colour number in the current cue for each unit,
and the times designated for the tilt and colour changes. While a cue is playing, the table
will constantly be updated to show the current intermediate position of all moving units.

The Cue List

The second window on the screen is the Cue List, which will summarise details of each
cue:
It too can be sized (in length but not in width) and moved about the screen with the 
OPTION key. Initially it holds only the one preset cue; as additional cues are written, 
they will be added to the list.

In addition to the cue number, the list shows the length of the longest timed element in 
the cue, which one of several available types of cues has been chosen, and additional 
information that may be applicable to some of these types. There is also a field in which 
brief descriptions or comments may be entered.

The Control Window

At the bottom of the screen is the Control Window, from which movement through the 
cue-sheet is directed:

It's size is fixed, but it can be repositioned.

The functions of 'Play', 'Stop' and 'Pause' – which becomes 'Resume' when play is in a 
Paused state – are self-evident; 'Goto' is an immediate execution that disregards the time 
values in a cue and moves the units at a rapid rate directly to their target positions. All of 
these functions are also accessible in the Play menu; additionally, Goto and Play may be 
triggered from the keyboard by RETURN and SPACE respectively.

The 'Stop' command is active at all times, and will always send a 'Stop-all-movement' 
instruction to all on-line instruments.

In addition, the Control Window shows what will be referred to as the 'goto cue': this is 
the next cue to be executed, whether by Play or Goto command. Normally this is the next 
higher-numbered cue after the current cue shown at the top of the screen, but the number 
of any existing cue may be entered in the box, or selected by clicking on its line in the Cue 
List.

Near the lower-right corner of the screen display is another size box; this one relates to 
the main screen backplane as a whole, initially extending full width (on a standard 
screen) from just below the menu bar to the bottom of the display. This too can be sized
to any height and width, and repositioned with OPTION-drag, but note that the two main displays – the Units Table and the Cue List – will be visible only where they appear superimposed on this background.

There are additional windows, which can be summoned as required from the Windows menu:

The Timer Window

The Timer window, which is initially located just below the menu bar, gives a running display of elapsed and remaining time during the real-time execution of cues:

While a cue is being played, the left number increments to represent elapsed time since play began, and the right number decrements to show the remaining time in the longest element of the cue. The central, static, number is the total cue time.

Clicking on the arrows at either end of the scroll bar will expand or shrink the total running time by one second for each click. Keyboard equivalents are the up- and down-cursor keys. A square-bracketed number will appear beside the total cue time indicator, showing the number of seconds added to or subtracted from the original cue length.

Clicking in the shaded area of the scroll bar on either side of the moving indicator will expand or shrink the total time by increments of five seconds per click. Keyboard equivalents are SHIFT/up- and down-cursor keys.

The Manual Fader Window

The Manual window, initially located at the right edge of the standard Macintosh screen, provides a fader control for manipulating the DIGITAL LIGHT CURTAIN s while writing cues and setting Minimum and Maximum limits, and for the execution of Manual cues (see Writing Cues, Limits, Manual Cues):
The Delta Window

The Delta window shows a different aspect of the cue-sheet, displaying only those values that are to change in the forthcoming cue, and expressing them in terms of the amount of change rather than in absolute units:

In the illustration above, Unit 13 is about to move 43.4° in a negative direction from its current position (whose precise value cannot be seen in this display), and to advance its colour by two positions.

If the 'goto' cue is altered – by changing the value in the goto box of the Control Window (see Control Window) – the Delta display is immediately redrawn accordingly.

The Status Window

The Status window displays the DIGITAL LIGHT CURTAIN's state of operational readiness, and incorporates a number of further commands in this area (see Unit Status, On-Line / Off-Line, Calibration, Limits):
The commands in the Status window will not be activated until the Light Talk Network has been Initialised (see *Initialising the Light Talk Network*) and one or more units have been selected from the Status list.

Each of these four windows can be repositioned by placing the mouse on its shaded control area and dragging. The Delta and Status windows can also be sized, subject to limitations imposed by their configured formats and the screen size. Each has a Close box in its upper-left corner with which to remove it from the screen.

A window’s new location and size can be stored with the cue-sheet’s configuration data by clicking on its shaded control area while pressing the OPTION key. This will cause its position and size to be ‘remembered’ each time the cue-sheet is reopened, rather than reverting to its defaults.

Remember that the table widths selected in Configure determine to an extent the permissible range of sizes that can be achieved. You may return to Configure at any time if you find that a different format would better suit your purposes. Reconfiguring will cause ‘remembered’ layouts to be lost; all display elements will revert to their default locations and sizes and must then be repositioned as required.

**Initialising the Light Talk Network**

Each individual instrument is identified in its own on-board circuitry by an electronically coded serial number. Commands from the computer to the instruments are addressed in terms of the Unit Numbers shown in the various screen displays. Configuration establishes a table of Unit Numbers and their corresponding Serial Numbers for reference by Light Moves. It remains necessary to inform each device of its Unit Number assignment, so that it may be able to determine whether a command is addressed to it. This data is stored in the device’s volatile RAM – memory which dissipates when the power is interrupted – and must be re-established from Light Moves’ Configuration table each time power is restored to the Light Curtain. It should also be done whenever a new (i.e. different) cue-sheet is opened, even if power to the instruments has been maintained, in case the unit number assignments are not the same as those in the previous cue-sheet.

The process is called Initialisation. Pull down the •Special• menu:
Observe that 'Light Talk Network', which is dimmed because it is not normally an accessible command, is at the moment also un-ticked, indicating that the Network is inactive. This is a reminder, if one is needed, that the units have not yet been initialised and are therefore not capable of interpreting commands from Light Moves.

Choose 'Initialise Network...' from the menu.

Should Initialisation not succeed immediately, you will see:

It is worthwhile retrying, as the failure may have been due to interference or some other temporary cause, and a second attempt may then succeed. If the message appears a second time, a more serious problem is indicated. Clicking on 'Cancel' will abandon the attempt to initialise and permit you either to remedy the problem, or to continue working without the DIGITAL LIGHT CURTAIN s on-line.

'Force Netwk.' is a means of creating an entirely artificial situation in which Light Moves behaves as though it were communicating with the DIGITAL LIGHT CURTAIN s, even though Initialisation has failed. All program functions that depend on the presence of an active Network are enabled. Commands will be sent to the Light Curtains in the normal manner, but operations that would normally generate a response from the instruments will be terminated inconclusively or, in some cases, may enter an endless loop from which evasive action must be taken – keying CONTROL is usually the escape route. It must be stressed that this is an abnormal situation, and that the behaviour of the Control Program when the Network has been forced can lead to unpredictable conditions.

You will be asked to confirm this unusual action:
Clicking on 'Enable' or keying ENTER will send you immediately into the 'Patch...' command in the **Special** menu (see **Patch**). From here you can examine the state of the Network in an attempt to determine the nature of the problem. Likely causes are a disconnected Network cable, the absence of power to the DIGITAL LIGHT CURTAIN s, or the Network plugged into the wrong port of the Macintosh. Clicking on 'Cancel' will return you to the cue-sheet without enabling Network functions.

If the Network has successfully been initialised, you will proceed automatically to the 'Patch...' command.

Patch

The 'Patch...' command in the **Special** menu is the alternative way to assign unit numbers to DIGITAL LIGHT CURTAIN s if this has not been done in Configuration, or if it becomes necessary for any reason to alter existing assignments. Its display may also be used to provide a detailed description of the instruments currently on the Network. You are shown:

![Patch Window]

This box conveys a great deal of information. Consider the above example. Firstly, in the summary at the bottom, it reminds you that the current cue-sheet is configured for 20 DIGITAL LIGHT CURTAIN s, and that you have provided serial numbers for 19 of them. In the next column, it reports that 17 Light Curtains have been detected on the Network; 16 of them have been assigned their corresponding Unit numbers from the data in the Configuration table, and one has been found which could not be assigned because its serial number does not appear in the Configuration table.

The 'Unit' and 'Serial #' boxes are pop-up menus:
We can see from the menus that Units 1, 2, 4 and 7-20 have successfully been assigned, indicated by solid-diamond markers. Unit 3 has not been given a serial number in Configuration. Units 5 and 6 have been assigned serial numbers but are unable to find them on the Network, indicated by hollow diamonds. Dragging down to the bottom of the right-hand list below the '••••' separator, we can see that a Light Curtain with serial number #354 has been detected on the Network but has not been patched – assigned a corresponding Unit Number – because its serial number did not appear in the Configuration table.

Let's suppose that it is the intention to make the one unassigned unit found on the network – #354 – correspond to Unit No. 3, which at the moment is similarly unassigned. In the left-hand menu, select Unit 3. In the right-hand menu, select the unassigned serial number:

The 'Patch' button will become bold, and clicking on it will make the assignment. Both pull-down menus will be updated to reflect the new conditions, as will the summaries at the bottom of the box and the Configuration table itself – this could be confirmed by returning to Configure (in the Edit menu) for a look.

There remain two unit numbers without assigned instruments, so let's suppose now that two additional Light Curtains have hastily been hung, but no note was made of their serial numbers. The bottom of the right-hand menu – after clicking on 'Retry' to update the display – would now look something like this:
The summary at the bottom should now also show 2 unpatched units on the Network. So there are now two unit numbers lacking serial numbers, and two Light Curtains available for assignment. But not having noted their serial numbers when they were installed, which is which?

Select one of the unpatched serial numbers from the bottom of the right-hand menu and click on 'Wiggle'. If the unit has not been calibrated, a Tilt Calibrate operation will automatically be performed. Then the selected instrument will oscillate 15˚ in each direction for as long as the mouse button is held pressed, so that it can be identified visually. The speed of oscillation can be increased by holding down the OPTION key when clicking; it can be increased still more by holding down the SHIFT key. When the mouse button is released, the unit will stop oscillating. Now, having identified the instruments on the stage, the units can be patched as above.

The 'Unpatch' button does just that: it undoes the assignment of the unit number/serial number combination selected in the right-hand menu, leaving both unassigned.

'Swap' combines the 'Unpatch' and 'Patch' functions, interchanging the unit number/serial number assignments of the two pairings selected in the left- and right-hand menus. Thus if, say, Unit 7 is patched to Serial Number #349 and Unit 8 to Serial Number #351, selecting this:

![Diagram](image)

(or its reverse, Unit 8 in the Left menu and 7 in the right) and clicking on 'Swap' will cause Unit 7 to become assigned to Serial Number #351 and Unit 8 to #349. Note that it is not possible to Swap between a patched unit and an unpatched one, but the same result could be achieved by selecting the new target unit in the left-hand menu and the appropriate serial number in the right, then clicking on 'Patch', which will, in this case, Unpatch the right-hand combination before proceeding to effect the desired Patch.

Click on 'Exit' to return to the cue-sheet view. If in Stage mode, all units will be sent to their designated positions in the current cue.

Calibrating the DIGITAL LIGHT CURTAIN s

When the Light Talk Network has successfully been initialised and it is thus possible to communicate with the DIGITAL LIGHT CURTAIN s, the instruments themselves must each examine their own operating environment and establish positional references in terms of tilt and colour repertoire. As with Initialisation, this process must be performed every time the devices are powered up. Colour calibration must also be repeated if a new colour-roll is installed.

The command is invoked by the 'Calibration' ('Calibn...') button in the Status window, whose upper-left corner looks like this:
The six command buttons will be inactive and dimmed until one or more units are selected from the table below. Remember that rows and columns that are out of view can be selected by dragging the mouse beyond the table’s boundaries. When you have selected the units, the command buttons become enabled. Click on 'Calibration' (abbreviated 'Calib...'), and you are asked:

Tilt calibration causes all selected units to seek their calibration points, somewhere near the middle of their range of movement. Colour calibration causes them to scroll to the start of their colour rolls and then wind to the other end, making internal notes of the number of colours encountered and their widths. Tilt and colour can be calibrated separately or simultaneously. The default is 'Both'.

It may occur that a unit is unsuccessful in calibrating itself because of internal problems which it cannot resolve – a missing colour roll, for example, or one that has become detached from its roller. The scroller motor will wind, searching for the double tape that marks the end of the roll and failing to find it. The attempt will be abandoned eventually, but it may take a long time.

There is a cutout, if you feel that calibration has been going on for longer than the twenty seconds or so normally required: pressing the CONTROL key will abort the process and inform you which unit was at fault (if more than one, then the lowest-numbered one). You will then be in a position to determine the cause of the failure, or, if necessary, to carry on without the offending unit by switching it off-line.

On-Line / Off-Line

When the Light Talk Network has been initialised and the DIGITAL LIGHT CURTAIN has been patched to a Unit number, it is initially in the on-line state, scanning the Network for commands it can execute. It may occasionally become useful to isolate one or more instruments from the Network so that they remain inactive for a period, regardless of any commands that may be sent to them. This is the function of the 'Off-Line' command in the Status window.

Select the required units and click on 'Off-Line'. The check-mark in the first column of the Status display becomes an 'X':
In this condition, the only **Light Moves** instructions to which the unit can respond are those issued from the Patch screen. If Patch is called, all units are restored on-line. Otherwise, the unit will remain inactive until it is restored by an 'On-line' command from the Status window. It will ignore any Play or Goto commands that are executed. Any command in progress at the time the 'Off-line' instruction is sent will be aborted immediately, the unit remaining in whatever position it finds itself at the moment the instruction is received.

**Preview Mode / Stage Mode**

When **Light Moves** is first invoked or a new cue-sheet loaded, the program is in Preview mode. In this mode, the Light Curtains themselves are inactive; cues may be written and edited and you can step from cue to cue with the Goto command, or **Light Moves**' internal timer can be used to simulate the real-time progress of a cue with the Play command, and the simulated states of the units can be monitored in the display. But in Preview mode, no cue commands are actually sent to the **Light Talk Network**.

Once the Network has been initialised and communication with the devices established, the 'Stage' button is enabled and Stage mode can be entered.

The two modes maintain independent location counters. When a cue-sheet is first opened, it will be at Cue 1 in Preview mode. On entering Stage mode for the first time, the current Stage cue is set identical to the current Preview cue. Thereafter, changing the current cue in one mode will not affect the current cue in the other. Thus it is possible, for instance, to switch from Stage mode to Preview, leaving the Light Curtains in their active cue states, examine or even alter a (different) cue while in Preview mode, and then return to Stage mode, without any visible changes occurring on stage. It is not possible to change modes while a cue is being Played, or is Paused in the course of being Played; the 'Preview' and 'Stage' buttons will be inoperable until the cue has completed Playing, or has been terminated by a subsequent Stop or Goto command.

Note that upon re-entering Stage mode **Light Moves** always issues a 'Goto-current-Stage-cue' command, except on the first visit to Stage mode. The exception is significant, in that it is the basis of the recommended recovery procedure in the event of a computer failure (see **Recovery from Computer Failure**).

It should be kept in mind when changing between Preview and Stage modes that the state of the Auto-Save toggle may become reversed (see **Auto-Save**).

**Pre-Defined Groups**
A facility exists (which cannot be used in the Configure mode) for making multiple selections, through the use of pre-defined groups of units. This method is particularly time-saving if certain fixed combinations of units will need to be selected repeatedly.

Select the required combination of units, then choose 'Create Group' from the Edit menu. You will see:

![Create Group Interface](image)

'Group Name' can be any text you choose to identify this group of units. The number in the 'Cmd Key' box is the keyboard shortcut, when typed together with the Command ( ) key, for selecting this group. The next unassigned numeric key will automatically be shown, but you may alter it if you wish. You will be unable to enter keys that have already been assigned. Up to nine groups of units may be defined in this manner.

When all nine permissible command keys have been assigned, you can continue to define groups, which will have no keystroke command but can still be called from 'Select Group' in the Edit menu (see below). A large number of such groups can be defined. Such keystroke-less groups may be defined at any time – even if not all nine number keys have been assigned – by blanking the 'Cmd Key' box.

The 'Create' button becomes enabled when a name and an unassigned command key – or a blank in the 'Cmd Key' box – have been entered, and clicking on 'Create' will record this grouping for future use.

When next you want to select this same grouping of units, you can either key in and the assigned command key, or use the 'Select Group' command in the Edit menu:
The sub-menu will list the defined groups, and you may select one with the mouse or the appropriate keystroke. Note that the universal group 'Select All' is always present in the menu; SHIFT-Select All' deselects all units.

Having selected your group in this manner, Edit mode may be entered by choosing 'Edit Selection' in the Edit menu. More than one predefined group may be selected simultaneously by keying CONTROL and the appropriate selections from the side-menu, or CONTROL- and the appropriate command keys 1-9.

Facilities are also provided for changing the name of an existing group, altering the units constituting a group, and deleting a group altogether. Choose 'Edit Group' from the Edit menu and drag the mouse to the group you wish to alter in the sub-menu. The screen that appears,

allows you to select the appropriate function from the three buttons at the right. To rename the group, simply overtype the new name in the highlighted box; the 'Rename' button at the lower left will become enabled and can then be clicked to record the new group name. If 'Delete' is selected at the right, the legend in the lower-left button will change to 'Delete', and clicking on it will delete the group definition. If a regrouping is required, then all the members of the redefined group must be selected before invoking 'Edit Group'. You will then be able to select 'Regroup' at the right, and clicking on the lower-left button, now also titled 'Regroup', will store the altered definition.

The 'Master Unit'

Some operations that can be performed on multiple selections require a direct interface with one representative member of the group. Consider this example: it is possible to select a group of instruments for editing, manoeuvre them into their desired positions by visual criteria, and then record the numerical values of those positions as parameters in a cue.

Using this method, at the point when the correct position has been visually established, Light Moves next needs to ascertain what the numerical value of that position is. If does this by interrogating the device, which responds by reporting its current position. This value can then be entered into Light Moves' table of cue parameters.

This interrogation of the instrument must be directed to one individual unit, else the response would be an unintelligible jumble of simultaneous replies from each of the selected Light Curtain. This one unit to be interrogated will be the one designated the 'Master Unit'. This is always the one whose number remains visible in the pop-up menu. Which one of the selected units is to be so designated follows certain rules: if the units were selected by dragging the mouse, it will be the first one on which the mouse was clicked; if one or more predefined groups were selected, the Master Unit will be the lowest-numbered unit of them all; if the selection was made by SHIFT-Clicking, the Master Unit will be the last one so selected. It follows then that any unit can be designated the Master Unit of any grouping by SHIFT-Double-Clicking on it: it will be added to the selection if not already a member, and you will enter Edit mode with that unit as the Master Unit. Once Edit mode has been entered, it is not possible to alter
the Master Unit designation. It will be necessary to cancel the edit operation and adjust the selection.

**Light Moves**, then, ascertains the tilt position of the Master Unit and enters that value into its parameters table for all the selected units. In the case of a group of instruments that all started from the same numerical position this is all fairly straightforward, and the result will be just what you might have expected: the new tilt position for all the selected units will become that which you saw on the stage.

But consider now the case of a group of instruments whose initial positions were not identical. They can still, you will find, be moved as a group, their positions all being affected by an equal number of degrees in the same direction, but, having started from differing positions, their end-points will be correspondingly different. Now, when **Light Moves** interrogates the Master Unit, it will receive a reply which, while correct for the Master Unit itself and for any other units that started from the same position, will be incorrect for those that started at positions different from that of the Master Unit. However, the value that will be stored for all these units will be that for the Master Unit, resulting in something quite different from what was expected. If the cue is saved and run, the Light Curtains will go to new positions quite different from those you saw when you set the cue.

In this context, we introduce a new keystroke command: -DELETE or -click will blank out all data boxes in a dialog screen except the one currently holding the cursor. Please note that in this context a 'blanked' box is something quite different from a box containing '0', which after all is a value to a computer! Thus blanked, it will be safe to store a change involving the remaining parameter without the risk of sending the others – which may be at dissimilar values – to a common value.

**Cues and the Cue-Sheet**

Before discussing the plotting and editing of cues, we must consider briefly the nature and terminology of cues as used in **Light Moves**.

In discussing the building of a cue-sheet, we may speak of being 'in Cue 17', meaning that we are looking at the state the units have reached after execution of Cue 17. Or we might say that we are 'running Cue 17', meaning that we are somewhere in transition between whatever came before and Cue 17.

A **Light Moves** cue-sheet is a document containing configuration data and a number of individual cues, stored in ascending numerical order, regardless of the order in which they may be executed.

The data in each individual cue embodies the states of all units at a given moment, indicating their tilt and colour positions, and the time values in which those conditions are to be reached. A cue is not merely a list of the changes to be made, for it holds information relating to those values that are static in the cue as well as to those that are to alter. Thus conditions 'in Cue 17' will be entirely identical whether we have arrived there from Cue 16, or Cue 12, or Cue 120; it follows that **Light Moves** cues may be randomly accessed.

**Cue Numbers**

Cue numbers serve to identify and distinguish one cue from another, and to allow them to be stored in a logical, progressive sequence; the numbers themselves are arbitrary and do not relate to time or to anything else. While they are normally executed in ascending numerical order, and are always displayed so in the cue-sheet, they may be executed in any order desired by overwriting the number in the Goto box.

**Light Moves** accepts cue numbers in the range 0.1 - 999.9. There is no functional difference between
integer- and decimal-numbered cues, but the availability of decimal numbers makes possible the insertion of a limited number of new cues between existing ones without the need to renumber.

Writing and Editing Cues

One cue is always automatically present in a new cue-sheet and is designated Cue 1. The default preset positions in Cue 1 – tilt at 0˚ and colour at 1 – are quite possibly not what you will require; like those in any other cue, they may be altered:

Select one or more units in the unit table whose parameters you wish to alter. Enter Edit mode, either by choosing ‘Edit Selection’ from the Edit menu or by double-clicking within your selection, you will see:

If this was a multiple selection, the ‘Unit’ and ‘Colour’ boxes will in turn be pop-up menus:

The ‘Unit’ box or menu shows the units that were selected when Edit mode was entered. They may be individually deselected or reselected by choosing them from this menu.

The ‘Colour’ pop-up menu displays the positions and descriptions of available colours, as they have been defined in Configuration. Normally only whole-number values – colour centered in front of the lamps – can be selected by choosing from this menu. If a fractional value is needed, to produce split colour for special effect, it must be entered in the ‘Colour Position’ box below. But if a value containing a decimal already appears in the ‘Colour Position’ box, that fractional component can be retained while a new colour selection is made by holding down OPTION while choosing from the colour menu.

Values for both tilt and colour may be entered or amended directly in the four boxes on the bottom row.

‘Tilt position’ is the axial rotation of the selected unit(s), expressed in positive or negative degrees relative to each unit’s previously defined zero point. This value has a resolution
of up to one decimal place, and may not exceed a unit’s previously defined maximum or minimum values. Note that if this is a multiple selection and if the value entered exceeds the limits of any one of the selected units, it will not be accepted; the offending unit will have to be deleted from the group and addressed separately.

'Tilt Time' is the duration of the Tilt change, in seconds (to one decimal place) up to a maximum of 3600.0 (one hour).

'Colour Position' is the same parameter as appears in the pop-up 'Colour' menu above, except that the colours are referenced by their numeric positions on the colour roll rather than by name, and that it is possible to enter fractional values (to one decimal place) using this box rather than the pop-up menu. Note that when a value is entered here, the pop-up menu immediately responds with the name of the corresponding colour (rounded to the next lower integer value).

'Colour Time' is the duration of the Colour change, in seconds (to one decimal place) up to a maximum of 3600.0 (one hour).

Note that the times of tilt change and colour change are separate parameters and may be set to differing values.

It is also possible to designate a 'Manual' cue by keying the letter 'M' into the 'Tilt Time' box instead of a numerical time value. When a Manual cue is executed, the tilt will respond to movement of the manual fader control – up for positive rotation, down for negative, the speed being governed by the degree of movement of the fader.

If Stage mode is active, then on entering Edit mode the manual fader control appears on the screen.

Dragging the fader’s handle upward will cause the selected unit(s) to rotate in a positive direction, dragging it downward, negative. The speed of movement depends on the degree of fader movement. Releasing the mouse button will return the fader to its centre position and stop all movement in the selected units. Once movement has ceased the new position of the Master Unit (see Master Unit) is then entered into the appropriate box in the display.

Colour selection can be made in the same manner, by holding the OPTION key while acquiring the fader handle with the mouse.

Clicking on the 'Send' button will cause the selected units to move to the displayed tilt and colour positions. The movement will occur at fixed rates of 20° of tilt and 1.2 colours per second regardless of the times entered in the cue, and is intended simply to move the units rapidly to their new positions. Using 'Send' does not alter the current cue, and the units will automatically be returned to their original positions if the edit is later cancelled.

When the required alterations have been made, clicking on 'OK' will close the edit box incorporating any changes into the unit parameters table, and the Time value in the cue list will be that of the longest time element in the cue. If the DIGITAL LIGHT CURTAIN s are active, they will move to their new positions.

Clicking on 'Cancel' or keying ESCAPE will cancel the edit without recording any changes, and restore any active units to their original positions.
A word about multiple selections: generally all selected units will be given identical values in all parameters, since the values entered in the boxes will all be transferred to their respective positions in the Unit list for all selected units when 'OK' is clicked. It is possible, however, to edit one or more parameters for the selection whilst leaving others unchanged whether identical or not: entering a blank in a box – note that a blank is not the same thing as a zero! – will prevent that parameter from being updated. Keying while clicking in the box you wish to alter, or placing the cursor in that box and then keying -DELETE, will blank all other boxes, allowing that one parameter remaining on display to be edited while those with no value shown will retain their current values, even when they are not identical in all selected units. Conversely, the previous value may be restored to a box that has been blanked or overwritten by keying OPTION while clicking in the box, or by placing the cursor in that box and then keying OPTION-DELETE.

Saving Cues

With a modified cue in memory, there are several options for recording it in the cue-sheet. They are found in the Cue menu:

- **Save Cue** - This command simply saves the modified cue as the current cue, retaining the same cue number.

- **Save Cue As...** - This command, or -K from the keyboard, saves the modified cue under a new cue number. You will be shown a box:
The number is Light Moves’ suggestion, and represents the next unassigned integer cue number higher than the one being modified; you may accept it or overwrite another, including decimal values.

If you attempt to assign a cue number already in use, you will see:

![Overwrite Cue 3? dialog]

You may then either confirm your instruction, in which case the new cue will be written and the existing one of that number will be lost, or cancel, returning to the previous box so that a different cue number may be assigned or the new cue abandoned entirely.

Auto-Save / Never Ask Save

The 'Auto-Save' and 'Never Ask Save' toggles in the Cue menu are two mutually exclusive flags that can set the standard form for dealing with modified cues. Choosing them from the menu toggles their states on (ticked) and off. Note that, while both may be set to OFF, they cannot both be ON: setting either to ON will automatically set the other to OFF.

If both Auto-Save and Never Ask Save are OFF (unticked), then you will be asked to confirm your intentions whenever you issue a command that would cause the modified cue data to be lost; either when going to or playing another cue, on a Configure or Print command, or when changing between Preview and Stage modes:

![Save changes to Cue 1 before GoingTo cue? dialog]

You may then choose whether to overwrite the existing cue with the new values (click on 'Yes'), to ignore the changes and keep the existing cue (click on 'No'), or to abort the command you have just given (click on 'Cancel').

If Auto-Save is ON, the above dialog is skipped and the altered cue will automatically be saved under the current cue number.

If Never Ask Save is ON, the dialog is similarly skipped, and the altered cue data will be discarded, leaving the current cue as it originally was.

Note that there are actually two Auto-Save flags, one governing Preview mode and another governing
Stage mode, and that they may be set to opposite values. The default condition of Auto-Save, upon entry to Light Moves or opening a new cue-sheet is ON in Preview mode, and OFF in Stage mode. Never Ask Save defaults to OFF.

When changing from Preview to Stage modes or vice versa, it is the condition of the Auto-Save flag in the earlier mode that determines the action to be taken.

Revert to Saved

The 'Revert to Saved' command in the Cue menu will restore a modified cue to its last saved state.

Delete Cue

'Delete Cue' in the Cue menu will remove the current cue from the cue-sheet. You will be asked to confirm:

![Are you sure you want to delete the active Cue 2.1?](image)

No further checks are made to ascertain whether the cue is part of a linked or chase sequence; clicking on 'Delete' will remove the cue, 'Cancel' aborts the command.

Note that it is always the current cue that is deleted; it may be necessary to issue a Goto command to ensure that the target cue is the current cue.

New Cue

The 'New Cue' command in the Cue menu will create a cue with values as in the default preset cue: all units to Tilt 0˚in 10 seconds, Colour 1 in 10 seconds. As with the 'Save Cue As...' command, Light Moves will suggest a number for the new cue, which may be accepted or overwritten.

Cue Types

Below the Units Table is the Cue List. This table determines which of several possible types of execution is to be applied to a cue.

When a new cue is created, it is inserted in its proper numerical position in the Cue List. Double-clicking on the cue in the Cue List summons an edit box:
The 'Type' box is a pop-up menu of the types of fade available:

Cross Fade is a linear transition from one position to another. All changes occurring in the cue will start when the cue is transmitted to the Network, and the duration of the transition will be as programmed in the cue for each individual unit.

A Link Cue is a Cross Fade that, additionally, will proceed automatically to another cue after a given interval. Selecting Link will cause new edit box to appear:

The number in the 'Link' box is indicates the cue which is to follow the current one; Light Moves will suggest the next cue in the list if there is one, otherwise the next higher available decimal number, but any cue number may be entered. 'Delay' is the time interval between the start of the current cue and the execution of the link; again, the Program will suggest a delay equal to the length of the longest timed element in the current cue, so that the link will occur immediately upon completion of the cue, but any value may be entered.

If a link is entered to a cue that does not exist, you will be advised:

You will not be prevented from clicking on 'OK' and recording the link, but you are thus reminded that the missing cue still has to be written.

A Chase Cue is one of a series of linked cues that form a loop, cycling through the sequence for an indefinite period until a Breakout command is received; at that point, wherever it may be in the cycle, the Breakout Cue is executed, and the sequence comes to
an end.

When Chase is selected, another box appears:

```
<table>
<thead>
<tr>
<th>Type</th>
<th>Link</th>
<th>Delay</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chase</td>
<td>2.1</td>
<td>30</td>
</tr>
</tbody>
</table>

Description: [ ]

Break Out: 2.8

Cue 2  | Skip Cue

OK  | Cancel
```

As with Link Cue, Light Moves’ suggested values may be overwritten; a warning is shown if either the Link cue or the Breakout cue does not exist.

In each of the three types of cue, the 'Description' box may be used for a brief note that may help to identify the cue as it appears in the Cue List; it might be especially useful as a reminder to the operator that a Manual cue is imminent. The comment field may be left blank without affecting operation. Some types of Remote Control interfaces require a brief coded character string to be placed at the start of the comment field.

The 'Skip Cue' box, if ticked, will cause the cue to be skipped when executing a cue-sheet sequentially through repeated Play or Goto commands. The cue may still be used if its number is expressly entered in the Goto box of the Control Window, but automatic sequencing will bypass it.

Unit Status

When the Light Talk Network has been initialised, and one or more units are selected from the Status window, the 'Status' command may be used to obtain a display in some detail of the operational condition of the selected unit(s).

With the Status window on your screen and one or more units selected, click on the 'Status' button. All selected units are queried in turn, and the results entered into the Status window display:

```
<table>
<thead>
<tr>
<th>Status</th>
<th>On-line</th>
<th>Colibn...</th>
</tr>
</thead>
<tbody>
<tr>
<td>ClearErr</td>
<td>Off-line</td>
<td>Limits...</td>
</tr>
</tbody>
</table>

On  Unit Tilt Colour Errors

1  
2  
3  
4  

5  
6  
```

The illustration shows four units selected and each in a different state of readiness. Unit 1 is probably unassigned or not present, as the dots in the first column indicate that it has not responded to the status request; Unit 2 is on-line, but neither tilt nor colour are calibrated; Unit 3 is off-line; Unit 4 is fully operational, being on-line with both tilt and colour calibrated.

Error Flags
Note that Unit 2 also shows error conditions, represented by the figures in the Errors columns. Ten distinct error types can be identified (from left to right):

<table>
<thead>
<tr>
<th>Column</th>
<th>Error type</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Colour calibration error</td>
<td>End markers found unexpectedly</td>
</tr>
<tr>
<td>2</td>
<td>Tilt calibration error</td>
<td>End of travel found unexpectedly</td>
</tr>
<tr>
<td>3</td>
<td>Not used in Light Moves</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Argument range error</td>
<td>Numerical argument exceeds permitted bounds</td>
</tr>
<tr>
<td>6</td>
<td>Receiver overrun</td>
<td>Too much data for receiver buffer</td>
</tr>
<tr>
<td>7</td>
<td>Bad argument</td>
<td>Wrong number or type of argument received</td>
</tr>
<tr>
<td>8</td>
<td>Bad instruction</td>
<td>Unrecognised instruction received</td>
</tr>
<tr>
<td>9</td>
<td>Unexpected character</td>
<td><em>Light Talk</em> syntax error</td>
</tr>
<tr>
<td>10</td>
<td>Receiver error</td>
<td>Receiver parity or framing error</td>
</tr>
</tbody>
</table>

The numbers shown are the number of errors of each type that have occurred, with a dash representing nil and an asterisk (*) any number greater than 9.

Error counts are cumulative: they increment on successive errors until they are specifically cleared. This may be done by clicking on ‘Clear Err’.

**Limits**

The ‘Limits’ command in the Status window provides a means of setting the minimum and maximum tilt limits and the zero position (minimum and maximum tilt may also be set in Configure).

The Light Talk network must be initialised and the DIGITAL LIGHT CURTAIN’s tilt-calibrated. Select the required units from the Status window, and click on ‘Limits...’:

The Manual Fader window will also appear if it was not already on screen.

The ‘On Stage’ box will initially show the current position of the selected unit, or of the ‘Master Unit’ if a multiple selection (see Master Unit). The ‘Minimum’ and ‘Maximum’ boxes similarly will initially show the current values of these parameters.

The ‘Unit’ box is a pop-up menu of all the units that were selected from the Status window. Units may be deselected and reselected by choosing them from this menu.
The position of the selected unit(s) may be adjusted by moving the manual fader, or by entering the destination position into the 'On Stage' box and then clicking on 'Send'; the value in the 'On Stage' box will change to reflect the new position.

A new zero position may be set – for example, to bring a group of Light Curtains into precise alignment – by positioning the instrument to the desired zero point, selecting 'Set Zero to Current Stage Position', and then clicking on 'Set'. The new zero position becomes active immediately, and all subsequent positions will be in reference to it.

It is important to remember that a new zero can only be set by first positioning the affected instrument(s) to the intended position.

New Minimum and Maximum positions, however, take their values directly from the data entered into their respective boxes. The instrument itself need not be moved, although it may be convenient to establish the intended position by moving the DIGITAL LIGHT CURTAIN and then using the 'Copy' and 'Paste' commands in the Edit menu to transfer the value from the 'On Stage' box to the appropriate limit box. Selecting 'Set Minimum/Maximum Tilt' and clicking on 'Set' then sets the new limit.

It should be borne in mind that when a new zero has been set, the Minimum and Maximum limits will be referred to this new zero, and may consequently need to be adjusted in compensation if they are to remain at their former absolute positions.

'Reset Zero from Stored Value' is a safety measure that will probably never have to be invoked: In the extremely unlikely event of a DIGITAL LIGHT CURTAIN’s on-board Parameter RAM (PRAM) becoming corrupted and the instrument “forgetting” its zero position, this command will restore its zero position from those stored in Light Moves’ internal tables.

Finally, when 'Exit' is clicked, you are returned to the cue-sheet and if in Stage mode all units are restored to their proper positions.

Light Talk

'Light Talk', in the •Special• menu, allows you to communicate with the DIGITAL LIGHT CURTAIN’s on the most primitive possible level: in their own command language Light Talk. This command can be used at any time, whether in Stage or Preview Mode, and whether or not the Network has been initialised. See Appendix 2 for a full description of the Light Talk language.

You are given a screen with the cursor flashing in the top box:

Any Light Talk command typed in this box will be transmitted to all devices on the Light Talk Network by clicking on the 'Send' button or keying RETURN. The command will then appear in the 'Sent'
The numbers preceding the commands and replies represent the state of an internal timer at the time of transmission; they are not in themselves meaningful, but they increment in tenths of seconds, and can be useful in reconstructing the sequence of commands sent and received. Thus in the illustration above, one can infer that the reply on the second line of the 'Received' column clocked at 137.1 was in response to the query on the third line of the 'Sent' column, transmitted at 137.0. The count recycles to zero after reaching 999.9.

The columns scroll downwards as they fill, so that the most recent command and reply are always uppermost. No attempt is made to place a reply in the right column on the same line as the command in the left that elicits it.

Note the button to the right, labelled 'STOP': this instantly accessible control duplicates the 'STOP' button on the Cue Control Window, which is normally obscured while the Light Talk screen is present; it causes all movement in all Light Curtains to stop immediately.

The 'Light Talk' menu command presents an opportunity to create havoc on a considerable scale and even to cause damage to the DIGITAL LIGHT CURTAIN's. It should only be used with extreme caution.

DLC Commands

'DLC Commands', in the •Special• menu, gives access to a sub-menu showing a number of additional commands specific to the DIGITAL LIGHT CURTAIN that may at times prove useful:

These are essentially command statements transmitted via Light Talk, but ready-made for instantaneous transmission, without requiring any understanding of the Light Talk language.
The current release comprises the following commands:

- **Colour Count**: returns the number of colours in the selected unit(s) – a click on the response panel, or any keystroke, clears the panel and displays the next;
- **Device Type**: returns device description;
- **Device Version**: returns version number of device firmware;
- **Reset Selected Units**: restores the unit to its state at power-on. You must then reinitialise the network and recalibrate the unit before you can use it again;
- **Stop Selected Units**: all movement in the selected units is immediately stopped – in contrast to the 'Stop' button, which stops all units.

**Write PRAM**

The 'Write PRAM' command in the •Special• menu causes minimum and maximum tilt, and tilt and colour direction to be written from **Light Moves**' internal tables into the (non-volatile) parameter RAM (PRAM) of the selected DIGITAL LIGHT CURTAIN s. Changes made to these parameters by the **Limits** command will take immediate effect, and 'Write PRAM' should not then be used but after any of these parameters have been altered in **Configure** the changes will only become effective following a 'Write PRAM' command.

The 'Write PRAM' command can be executed only after the **Light Talk** Network has been initialised.

**Remote Command**

The 'Remote' command in the Play menu is a toggle which, when ticked, permits operation of **Light Moves** from a lighting desk. The command is accessible only if the appropriate serial port assignment has been made (see **Configuration**).

When 'Remote' is toggled OFF (no tick-mark), commands issued from the lighting desk will have no effect on **Light Moves**.

See the notes for specific remote interface options supplied with your software for more details.

**Monitoring Light Talk**

At any time when running **Light Moves** the activity on the **Light Talk** network can be viewed by holding down the SHIFT and OPTION keys. When a command is issued or a response received a box will appear on the screen echoing the data that was sent to the Network:
Light Moves will halt while the data is displayed, but of course the DIGITAL LIGHT CURTAIN s themselves will continue to execute any instructions they have received. The display is returned to normal by clicking the mouse anywhere or by any input from the keyboard.

Recovery from Computer Failure

Should you find yourself having to reset the computer in performance conditions, control can usually be regained without disrupting the visible states of the DIGITAL LIGHT CURTAIN s, providing that the instruments themselves have not suffered disruption.

Reset the computer. Any commands in progress will continue, under the control of the DIGITAL LIGHT CURTAIN s' on-board circuitry.

Reopen Light Moves and your cue-sheet.

Do not Initialise the Light Talk Network. Do not enter Stage mode. Do not recalibrate the instruments.

While still in Preview mode, goto the last cue played before the failure occurred.

Holding down the CONTROL key, choose 'Light Talk Network' in the •Special• menu. The 'Stage' button will become activated.

Click on the Stage button to enter Stage mode; since no Goto command is sent to the Network the first time you enter Stage mode, the transition should be invisible and leave you ready for the next cue.
Appendix 1: Colour Roll Specification

Colour Roll Specification
Index

INDEX

Auto-Save ........................................... 3
Breakout ........................................... 33
Calibration ......................................... 22
Chase Cue .......................................... 33
Clear Error ......................................... 35
Clone As... ......................................... 13
Colour Scroll Installation ..................... 2
Colour Scroll Preparation ..................... 2
Configuration ..................................... 7
Connections ....................................... 3
Control Panel .................................... 15
Copy As... .......................................... 13
Copy Colours ...................................... 10
Cross Fade ........................................ 33
Cue List ........................................... 14
Cue Numbers ...................................... 27
Cue Types ......................................... 32
Cue-Sheet .......................................... 27
Current cue ....................................... 14
Delete Cue ......................................... 32
Delta Window ..................................... 17
Display ............................................ 13
Editing Cues ...................................... 28
Error Flags ........................................ 34
Goto cue .......................................... 15
Group Selections ................................. 24
Handling Precautions ......................... 1
Initialising the Light Talk Network .......... 18
Installation ........................................ 3
Lamp Installation and Replacement .......... 1
Light Talk .......................................... 36
Light Talk Commands ......................... 36
Limits ............................................... 35, 37
Link Cue .......................................... 33
Locked Cue-Sheets ............................... 6
Manual Cue ....................................... 29
Manual Fader ..................................... 16
Master Unit ....................................... 26
Monitoring Light Talk ......................... 37
Network Link ..................................... 3
Never Ask Save .................................. 31
New Cue .......................................... 32
Off-Line .......................................... 23
On-Line .......................................... 23
Patch ............................................... 20
Power Supply ..................................... 1
Preview Mode .................................... 24
Pull-Down Menus ................................. 26
Recovery from Computer Failure .......... 39
Remote Command ............................... 38
Remote Control ................................. 1

2
<table>
<thead>
<tr>
<th>Feature</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Command</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>8</td>
</tr>
<tr>
<td>Remote Control</td>
<td>12</td>
</tr>
<tr>
<td>Revert to Saved</td>
<td>32</td>
</tr>
<tr>
<td>Running Light Moves</td>
<td>5</td>
</tr>
<tr>
<td>Save Cue As...</td>
<td>30</td>
</tr>
<tr>
<td>Skip Cue</td>
<td>34</td>
</tr>
<tr>
<td>Stage Mode</td>
<td>24</td>
</tr>
<tr>
<td>Status Window</td>
<td>17</td>
</tr>
<tr>
<td>The Colours List</td>
<td>11</td>
</tr>
<tr>
<td>Timer Window</td>
<td>16</td>
</tr>
<tr>
<td>Trap</td>
<td>38</td>
</tr>
<tr>
<td>Unit Status</td>
<td>34</td>
</tr>
<tr>
<td>Unit Table</td>
<td>14</td>
</tr>
<tr>
<td>Write PRAM</td>
<td>37</td>
</tr>
<tr>
<td>Writing Cues</td>
<td>28</td>
</tr>
</tbody>
</table>